Information Literacy Program

NVivo11

Introduction

2017
# Table of Contents

**Introduction to NVivo** .................................................................................. 4

**First Steps in Setting up an NVivo Project** .................................................. 4

**The NVivo Workspace** .................................................................................. 5

**Classifications Area** .................................................................................... 5

- What are Attributes & Values? ........................................................................ 6
- Creating Classifications and Associated Attributes ....................................... 6
- Applying Classifications & Associated Attributes .......................................... 7
- Creating Relationship Classifications ................................................................ 7

**Sources Area** ................................................................................................ 7

- Importing Data Files .......................................................................................... 8
- Importing Social Media and Web Pages NCapture .......................................... 9
- Web Pages .......................................................................................................... 9
- Facebook/Twitter ............................................................................................... 9
- YouTube ............................................................................................................ 10
- Adding External Data Sources .......................................................................... 10

**Nodes Area** .................................................................................................. 10

- What is a Node? ................................................................................................. 10
- What is a Case Node? ........................................................................................ 11
- Opening a Node to View All the References Coded to It ................................ 11
- Reference Tab Information .............................................................................. 11
- Creating a New Node & Case Node from Scratch ......................................... 11
- Organising Nodes ............................................................................................. 12
- Creating a Relationship between Cases ......................................................... 12

**Coding Your Text Data** ................................................................................ 13

- What is Coding Context? .................................................................................. 13
- What is Coding-On? .......................................................................................... 13
- How to Code a Selection of a Document to a Node ........................................ 13
- Coding Data to a Relationship Type [Optional] .............................................. 13
- How to See What Has Been Coded within a Source ...................................... 14
- Coding Audio and Video data ......................................................................... 14
- Coding Pictures ............................................................................................... 15
- Uncoding Within Nodes and Sources ............................................................. 15
- Giving an Entire Source a Classification and Attributes ............................. 15
- Coding an Entire Source to a Node [Optional] ............................................... 15

**Collections Area** .......................................................................................... 16

- Creating Annotations ...................................................................................... 16
- Creating Memos ............................................................................................... 16
- Creating Links ................................................................................................. 16

**Deciding on a Coding Scheme: Word Frequency Queries** ......................... 17

- Word Frequency Results ................................................................................ 18
- Word Clouds .................................................................................................... 18
- Tree Map ......................................................................................................... 18
- Cluster Analysis .............................................................................................. 19
- Expanding the Context of References ............................................................. 19
- Creating a Node from Query Results .............................................................. 19
- Excluding Irrelevant Words from Searches .................................................. 20
NVivo Introduction

Creating Transcripts ........................................................................................................ 20
  Transcribe Mode ........................................................................................................... 20
  Normal Mode ............................................................................................................... 20
  Dividing Media ............................................................................................................ 20
  Custom Fields in Transcripts ......................................................................................... 20

Other resources ................................................................................................................ 21
NVivo Introduction

Introduction to NVivo

NVivo can do a phenomenal number of things to help you analyse your qualitative data. It can also help you analyse a large variety of source material: text, audio, video and pictures. This course will show you how to use the most commonly needed NVivo tools in data analysis for all of these formats. For further information about NVivo’s full capabilities, please refer to the NVivo 11 help website: http://help-nv11.qsrinternational.com/

This session will cover:

- Recommended steps in setting up a Research Project in NVivo.
- Tour of the NVivo Workspace and the Navigation View.
- How to set-up broad source material descriptions, relationships and demographics in Classifications.
- How to create and import data files.
- How to view and organise coding schemes in the Nodes Area.
- How to manually code and uncode text, sound, picture, and video.
- How to create Memos, Link and Annotations in Collections.
- How to begin the coding process using Queries.

When you open NVivo it will ask you to create a user ID: enter your Initials (must be unique to the Project) and (optional) your name. This is important when you’re collaborating with others.

Open the sample project to explore how NVivo can be used to analyse your data. When you open NVivo, at the top of the Welcome Screen there is an option to open a new Sample Project. Select the sample project which is a two-year study (2008-2009) documenting community perceptions of development and land-use change on coastal communities in the Down East area of Carteret County, North Carolina, USA.

IMPORTANT: Save the Project in your My Documents folder. Go to File choose Copy Project and save the file as Sample Project (2). Saved Projects can be opened on any computer with NVivo and can be altered any collaborator (a record of who changes what is kept according to User ID).

First Steps in Setting up an NVivo Project

It may seem counterintuitive, but setting up an NVivo Project is more efficient if you create your research project variables BEFORE importing any data. **The recommended steps are as follows:**

1. Identify what your Cases will be. These will be stored in the Case Nodes folder in the Nodes Area, and determine your Case Classifications in the Classifications Area.
2. Set up your “Independent Variables” (e.g., groups for later comparison) in the Classifications Area.
3. Import your Data Sources and create Case Nodes.
4. Apply Classifications and assign Attribute values to your Sources and Case Nodes.
5. Set up your “Dependent Variables” (the themes you want to code and count) in the Nodes Area.
6. Create Contextual Nodes if needed (e.g., a Node for each survey question/report section).
7. Prepare your project for collaboration.
The NVivo Workspace

The Navigation View is where you can easily navigate the different Areas of your NVivo Project. When you click on an Area in the Navigation Pane, a list of folders in that Area appears at the top of the pane. When you click on a folder, the list of items it contains is presented in a window to the left called the List View. When you open an item in the List View, its content appears in the Detail View. The Ribbon contains commands in tabs. The Find Bar is a shortcut to search for items your Project. The Quick Coding Toolbar has shortcuts for coding your data. The Status Bar provides information for the Project Item you have open.

Note: Throughout using NVivo you’ll find that your best-friend is Right-Clicking: it gives you a context-dependent short-cut menu with all the appropriate options for the space/object clicked. This way you don’t have to remember which menu tab has the function you need.

Note: The Navigation View can be hidden to make more room on the screen by clicking the arrow symbol at the top right-hand side of the View.

Classifications Area

This Area includes the higher-order information about your Sources and Cases. It’s useful to set up Node and Source Classifications and their Attributes before beginning the importing and coding processes, particularly variables that will be useful for analysis later on, such as demographics like sex, age, occupation etc. By doing this first, you’ll be able to simply select the right boxes as you import source material and enter information about your participants.

What are Cases?

Cases are the units of measurement for your research project (e.g., if you want to be able to say: “X number of Universities do Y”, then Universities will be your Cases). You can have multiple types of Cases if you have more than one unit of measurement (e.g., a Case type for Person and a Case type for Organisation).
NVivo Introduction

In order to help NVivo identify your Cases for analysis (e.g., count how many individual people said X), you need to create a Case Node for each one. Case Nodes also allow you to see all the content relating to each Case (e.g., everything person A said) when you open it. These are filed as special types of Nodes in the Cases folder in the Nodes Area. [More on this later]

What are Classifications?

There are two types of classifications you need to apply to the higher-order information in your project:

- **Source Classifications** - information about the type of Source material in your project (e.g., Report, Interview, Journal Article or Web Page).
- **Case Classifications** - information about the Cases in your project (e.g., demographics like Person, Organisation, Location).

What are Attributes & Values?

Each Classification has a set of unique Attributes: the relevant variables that relate to the Classification. For example, the predefined Case Classification Person has Age, Sex and Occupation attributes. Within each attribute is a defined set of possible values (e.g., within Sex the options are Male or Female).

<table>
<thead>
<tr>
<th>Classification</th>
<th>Attribute</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person</td>
<td>Age</td>
<td>20-25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>26-30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31-35</td>
</tr>
<tr>
<td></td>
<td>Sex</td>
<td>Female</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Male</td>
</tr>
</tbody>
</table>

Source Classifications will have Attributes related to the type of Source material (e.g., bibliographic information about your reference material. Note: can import this information from EndNote).

Case Classifications will include the independent variables of your research: i.e. the characteristics of your Cases that you predict will have an effect on what is said. (E.g. if you believe that there will be differences between the states/territories in which the Universities operate, then states/territory should be in attribute of the classification for Universities.)

Creating Classifications and Associated Attributes

You need to set up classifications for Sources and Cases separately in NVivo11 and they will be added to the appropriate folder in the Classifications Area, but the process is identical.

Example: Create a Case Classification and Attributes for Dog.

In the Create tab area, click on Case Classifications. Create a classification called “Dog” and give it an (optional) description. This will create the classification and then you can add its Attributes. Right-click on the new Dog classification and select New Attribute. Give it a name and (optional) description, such as “Breed” on the General tab. Select its value Type (here text). On the Values tab, you can set up the different options for the Breed classification: click Add and enter a new value in the row that appears (assign a description
and/or colour if you wish), then click Add again to add others (e.g., “Beagle”, “Jack Russell”). Then click OK when you’ve finished (do not click ADD again as it will not let you continue until you add another). You can add other attributes to the “Dog” Node this way too.

Applying Classifications & Associated Attributes

When you have Sources and Cases in the Project you need to associate them with their relevant Classifications and assign Attribute values. To assign a Classification, you can select one or more Sources or Cases, right-click on the selection and go to the Classification section of the menu and choose the appropriate one (e.g., Person or Journal Article). Once the Sources/Cases have been classified, you need to open the Classification Sheet in the Classifications Area of the Navigation View to assign Attribute values.

Find the relevant Classification (e.g., Person) and double-click on it to open the Classification Sheet. This will consist of a spreadsheet with columns representing each Attribute and rows representing each Source/Case. You can select the appropriate Attribute values for each Source/Case in each cell of the table (either using drop-down lists or typing them in).

What are Relationships?

NVivo allows you to keep track relationships (or connections) which exist between Nodes and/or project items (e.g., a University may be a member of the Group of 8). Relationships are recorded and stored in the Relationships folder of the Nodes Area, but these have to be set-up in Classifications under Relationship Types first in order to apply them as relationships.

Creating Relationship Classifications

In the Nodes Area, you can record what relationships (or connections) exist between Nodes/Sources/Cases (they are stored in the Relationships folder), but these have to be set-up in Classifications under Relationship Types first in order to apply them as relationships.

Example: Create a Sibling relationship type.

On the Create tab, in the Classifications group, click Relationship Type. Enter a Name (e.g., Sibling) and (optional) Description and in the Direction list select a direction (e.g., Associative). Then click OK.

Sources Area

This is where you’ll store all of your project resources. You can not only store your qualitative data for analysis (e.g., interviews, surveys results), but also your research material (e.g., journal articles). There are 4 source folders:

- **Internals**: all the data and notes which you want NVivo to analyse should be stored here within the NVivo Project itself.
- **Externals**: links to data and notes which you don’t need NVivo to analyse can be stored here outside the NVivo Project (e.g., things that you cannot import into NVivo, PowerPoint slides, or really big files like audio and video that are better to store outside to save computing power).
- **Memos**: all the memos you create which are either linked or unlinked to project items (can also find these in Collections).
- **Framework Matrices**: summaries of source materials in grids where rows represent Cases (i.e., individuals) and columns represent themes (e.g., personal experience). (Not covered in this course)
NVivo Introduction

You can see the sources already imported into the Project by clicking on the appropriate source folder and the list of files will be displayed to the right in the List View Window Pane. To see the actual source, double-click on the file and it will open up in a new Window Pane called the Detail View on the right-hand side of the screen.

New folders can be created within the Source Area by right-clicking on the appropriate source folder, selecting New Folder and giving it a name (e.g., “Test Folder”) and (optional) description. You can also create new Internal Documents by right-clicking in the List View and selecting New Internal and new Document (new audio and video files will still need to be imported). Give it a name and (optional) description.

Importing Data Files

Apart from being able to create your own text documents within NVivo, you can also import data in the following formats:

- **Audio:** *.mp3, *.mp4, *.m4a, *.wma, and *.wav.
- **Spreadsheets:** *.xl, *.xlsx, Access database tables, ODBC database tables and text delimited files (*.csv, *.tsv).
- **Picture:** *.bmp, *.gif, *.jpg, *.jpeg, *.png, *.tif, and *.tiff
- **Web Pages:** as PDF files using NCapture.
- **Social Media:** Facebook, YouTube, LinkedIn and Twitter using NCapture.
- **Other:** survey responses from SurveyMonkey, Evernote notes, Outlook emails (as *.pdf) and supported attachments, and EndNote/Mendeley/RefWorks/Zotero data.

Example: Importing a *.pdf file

In Navigation View, click the name of the sources folder that you want to import the data file into. On the External Data tab, click the type of data you want to import. Under Import From, click the Browse button and then select the file you want to import, then OK. Change the Name and (optional) add a Description of the new document source, then click OK.

Note: Audio, Video, Dataset and PDF files need to be edited before import.

Note: You can select multiple document, PDF, picture, audio and video files, and import them into NVivo at the same time (datasets must be imported one-by-one). However, you will need to define the source properties after import, and NVivo will use the file name as the name of the source by default.

Creating Case Nodes When Importing Sources

When a source file represents one Case in your project, you can automatically create a Case Node for it and NVivo will code all of the text etc. in the file as belonging to that Case.

Example: Importing a *.doc file belonging to one Case

In Navigation View, click the name of the sources folder that you want to import the data file into (e.g., Internals). On the Data tab, click the icon for the type of data you want to import (e.g., Document). Select the file you want to import, then OK. If this file belongs to one Case (e.g., University), then click on the More button to Classify the document appropriately. Tick the Code sources at Cases located under and ensure Cases is selected, and click the Select button to choose the appropriate Classification. Once you’ve done this, click OK and OK again.
A new window opens and you have the option of changing the Name and (optional) adding a Description of the new document source. Then click the Attribute Values tab and assign the appropriate Source Classifications (if necessary) and Values, then click OK.

**Importing Social Media and Web Pages**

**NCapture**

There is an add-on for Internet Explorer and Google Chrome web browsers called NCapture for NVivo. It automatically converts web pages to pdf and social media conversations into spreadsheet tables ready for analysis. If your IE Browser does not have the NCapture icon visible: right-click at the top of the browser window and select Command Bar and the NCapture icon will appear. OR you can select Menu Bar and it will be available as an option under Tools. If your Chrome Browser does not have the icon visible, right-click on the menu icon and select More Tools then Extensions. If NCapture is not listed, click on the Get More Extensions link and Search the Store for NCapture. Click on the + Add to Chrome button, and it should load it and the icon will appear next to the url box.

**Web Pages**

**Example: Capturing and importing a Wikipedia Page in Google Chrome.**

To save pages as pdf and import them into NVivo: while you are on the web page in Chrome or Internet Explorer (e.g., the Wikipedia Page for your favourite author) select NCapture and click Web Page as PDF as the source type. Change the name (e.g., Agatha Christie) and (optional) enter a description and linked memo if you wish. You can also ask it to code the source at import by adding terms to the Code at Nodes box. Then click Capture.

In NVivo, go to the folder in which you wish to import the data. On the External Data menu tab, select From Other Sources and click From NCapture. Select one of the following options:

- **All captures not previously imported**: Selects all NCapture files in the current location that have not been previously imported into your project.
- **All captures**: Selects all NCapture files in the current location.
- **Selected captures**: Allows you to choose which NCapture files you want to import.

Then click Import.

**Facebook/Twitter**

When you are on the FB page, you can save the News Feed page or a User Wall as a PDF file only with NCapture. Follow the same directions as for web pages above.

If you are displaying Wall Posts for a Page or Group, or a Twitter Feed (e.g., www.Twitter.com/ANUmedia) you can use NCapture to save the content as a Dataset. In NVivo, go to External Data menu and import the captured file into a dataset table (spreadsheet). You have the option to Auto code Attributes based on User profiles (such as gender, age), conversation topic, or create Case Nodes based on Users. Import the data as above.

You can auto code this data by column in the dataset (e.g., by Hashtag or User) if you wish (more on this later). For other types of data imports (e.g., Evernote) see the NVivo 11 Help Site.

**Note:** You can merge social media datasets into one table for ease of analysis (takes note of where the files came from as Nodes). Tick the Merge matching social media datasets (including previously imported) check box, and any matching Facebook datasets are merged together (if they contain wall posts for the same User, Page, or Group).
NVivo Introduction

YouTube

When you use NCapture to capture video in YouTube, it creates a video source file which is essentially a shortcut link to the video in YouTube (essentially an External Source) which is played within NVivo. If the video is removed from YouTube you will not be able to play it. If you also capture the YouTube comments this creates a dataset within NVivo as an Internal source which can be analysed.

Adding External Data Sources

When you have large files, such as audio and video, it’s usually a good idea to add them to the project as an External Data Source rather than import them as part of the project. It reduces the sizes of the project file and saves on computing power when running analyses.

Please note that you will not be able to use NVivo to analyse the content of external sources, only the notes or comments you linked to them.

On the Create tab, select External and enter a name and optional description. On the External tab choose the External Type (e.g., Web Link) then select the content Type (e.g., Video). Enter the File/URL Path by clicking the Browse Button to locate the file. On the Attributes Values tab select a Classification Type and assign coding Attributes. Then click OK. The external will open in edit mode and you can enter content related to the external to be coded later on. If you want to open the external file, right-click on the external source and select Open External File.

Nodes Area

This Area contains all the information relating to the coding you have conducted to summarise your qualitative data.

What is a Node?

It might be easier to think of Nodes as being the same thing as Codes: they have the same names as the codes in your coding scheme and are organised in the same way. However, technically a Node is the term used for a special folder containing all the references you have coded as belonging to a specific theme. For example, all the text/audio/video in the sample project which refers to infrastructure has been coded to a Node called "Infrastructure". When you open the Node called "Infrastructure", you will see a summary of all the source material which has been coded as "Infrastructure" in the Detail View.

Nodes can be:

- **Free** - stand-alone topics/themes (e.g., Water Quality).
- **Tree** - hierarchical grouping of Nodes indicated by a +/- symbol to expand and collapse the tree. The higher-order Node is termed the "parent" and lower-order Nodes "children" (e.g., Attitude is a parent Node and Mixed, Negative etc. are its children).

Notes: Set-up Nodes for the codes you intend to use before coding your data. It helps to keep your coding within the scope of your research project.

Try to restrict Tree Nodes to the “child” level. It makes analysis simpler and helps to limit your Nodes to only the essential ones.

NEVER duplicate Nodes as it unnecessary and makes analysis more complex than it needs to be.
**What is a Case Node?**

In order to help NVivo identify your Cases for later analysis (e.g., count how many People said X), you need to create a Case Node for each one. Cases are also created as Nodes so you can see all the content relating to each Case (e.g., everything person A said) when you open it. These are filed as special types of Nodes in the Cases folder in the Nodes Area.

**Opening a Node to View All the References Coded to It**

The List View in the Node Area provides information regarding the number of Sources that are coded at the Node (e.g., how many text and video files), as well as the number of References (sections of text). You can see the actual content of the Node by double-clicking on it (e.g., Infrastructure) or right-click on it and select Open Node. The content is displayed the Detail View. Here you will find tabs on the right-hand side for:

- **Summary** - the sources of the references coded.
- **Reference** - the actual text coded with coverage details and number of codes assigned.
- Other tabs with thumbnail links to the actual Text/Picture/Audio etc. files.

**Reference Tab Information**

- **Header**: Name of the Source coded, blue hyperlink to that Source, total number of references in that source coded at the Node and percentage of coverage (e.g., X% of the Source coded in this Node).
- **References**: Number of times the reference was coded at the Node (>1 if multiple users coded it).
- **Coverage**: Percentage of the source that the reference coding represents:
  - Documents - percentage of characters in the entire source,
  - PDFs - average of percentage of characters and page area,
  - Datasets - number of characters in codable columns,
  - Audio/Video - percentage of timespan
  - Picture - percentage of pixels.

**Note**: Number of references includes any double-coding of sections by multiple users

**Note**: If the Node is a parent and has Aggregation turned on, then coding at any child Nodes is included when calculating coverage. (More on this later).

**Creating a New Node & Case Node from Scratch**

**NODES**: In the Nodes Area of the Navigation View, click on the Nodes folder. Right-click on the Detail View in the Nodes folder, and select New Node. You can also create Nodes by selecting Node on the Create menu tab. Give the Node a name (e.g., Test Node) and (optional) description (e.g., what the Code means and how it is to be applied) and click OK.

**CASE NODES**: In the Nodes Area of the Navigation View, click on the Cases folder. Right-click on the Detail View and select New Node. Alternatively, on the Create tab, click Case and type in the name and (optional) description on the General tab. You can also assign a specific colour to the Node in the drop-down menu if you wish. On the Attribute Values tab, you can relate the Node to a pre-specified Attribute (e.g., select the Person Classification and choose some of your demographics from the drop-down menu), then click OK.

**Note**: You can change classifications and attributes at any time by right-clicking on a Node, selecting Node Properties and changing selections appropriately.
Organising Nodes

Example: Create a folder for your Practice Nodes.

You can create folders to organise your Nodes in some meaningful way (e.g., create a folder to store Nodes you create in this course) to make them easier to find. Right-click on the Nodes folder to create a new one within it (e.g., My Practice Nodes). You can click and drag any Nodes into the new folder (e.g., Test Node), and click and drag to take them out.

Example: Merge Fisherman, Fishing and Fishing Industry Hashtag Nodes.

You can also merge similar Nodes together by selecting and cutting all but one of the Nodes; the remaining one will be the “target Node” you’ll merge them into (e.g. in the Autocoded Social Media folder cut Fisherman and Fishing) then click on the remaining Target Node (e.g., Fishing Industry). On the Home tab, click Merge and then Merge into Selected Node. Select the appropriate option:

- Merge child Nodes – If the Nodes being merged have child Nodes, move the children to the target parent Node as well.
- Copy see also links – Include any see also links in the merged content.
- Append linked memos – Add the content of any linked memos to the end of the target's linked memo.
- Copy relationships – If the Nodes being merged are part of a relationship, update the relationship to point to the target Node.

Then click OK.

Example: Making the Fish Hashtag Node a child Node of Fishing Industry.

If you want to create a Hierarchical (Tree) Node, you can do this by cutting one Node (the “child” e.g., Fish) and pasting it directly into another Node (the “parent” e.g., Fishing Industry). You can also use the click-and-drag method or cut-and-paste methods instead. It’s a good idea to consider aggregating your tree Nodes so that the parent Node will include all the references relating to its child Nodes: click on the parent Node then on the Home tab, click Properties and tick the Aggregate box on the General tab. All the Fish specific coding will also be included in the Fishing Industry Node.

Creating a Relationship between Cases

You can note important relationships between Cases and/or project items in this area of the Node View. For example, Margaret is a member of Carteret Catch.

Example: Creating a marriage relationship between Barbara and Ken.

Relationship types are created in the Classifications Area (see previous topic) and applied by selecting Relationship on the Create tab, selecting a Case/Node (e.g., in Cases → People → Interview Participants select Barbara), then choosing a Relationship Type from the drop-down menu (e.g., is married to) and selecting another Case/Node (e.g., Ken).
Coding Your Text Data

What is Coding Context?

When you begin to code your data it’s important to consider how much information to include in your Nodes: individual words, partial/whole sentences, paragraphs or even the whole document. You should provide as much context in your coded data in order to understand why it was coded in that way (particularly if a third-party looks at your data).

For example, if someone coded this sentence in a Groucho Marx quote: “I find television very educating.” to the Node TV informative, you would think that the coding was appropriate. However, if they had also included the next sentence of the quote to the Node “Every time somebody turns on the set, I go into the other room and read a book” you would realise the coding was incorrect. Therefore, when auto coding, it is important that you include a substantial amount of context in order to review the appropriateness of the coding to a Node.

There are 4 options when choosing a coding context in auto coding:

- None - the word only.
- Narrow - 5 words, seconds or percent, or the whole cell.
- Broad - whole paragraph/cell/row, 20 seconds or 20 percent.
- Custom - e.g., a fixed number of words on either side of the word match.

If you make a mistake, you can always spread the context after coding. See Expanding the Context of References later on.

What is Coding-On?

Often one sentence will be a relevant reference for more than one Node. Coding-on refers to coding the same content at a second, third or fourth Node (this is done in the same way as regular manual coding). This is why you never need to have duplicate Nodes.

How to Code a Selection of a Document to a Node

Method 1: Open a document from the Sources Area of the Navigation View (e.g., the ANU Home Page).

Click and drag your mouse to highlight the section of text that you would like to code under one or more Nodes. Right-click on the selection and choose Code Selection from the menu. Then choose to code at either Existing Nodes, New Nodes or Current Node (this is the last Node you coded at). Tick the appropriate box(es) and then click OK.

Method 2: Drag and Drop Coding. If you have your Nodes displayed in the List View above the Detail View of your source document, you can select the content you want to code then drag and drop the selection to the Node itself (you will get a confirmation message if it is successful).

Method 3: Quick Coding Bar (see illustration below). At the bottom of the window, there is a short-cut bar for coding (if you can’t see it, on the View tab, click Quick Coding, and then select Docked). Select what you want to code, then choose where you want to code it in the In drop-down menu: a. Nodes or Relationships. From the drop-down menu for b. Code At select the appropriate Node from the list. If you want to choose more than one, click on the box with the 3 dots next to the drop-down list, and tick all the appropriate Nodes. If you want to create a new Node, type in the name for that Node in the Code At box. Then click on the Icon for Code at Current Node to code it.
There are also icons for **c. Uncode at Selected Node** and to make a Nodes from the selected text (**d. Code in Vivo**) which automatically chooses the highlight text as the Nodes name (up to 256 characters).

### Coding Data to a Relationship Type [Optional]

**Example:** Code text within a Nodes to the “contributes to” relationship between **Community Change** and **Environmental Change**.

It can also be useful to code references within Nodes at the relationship level to collate information that supports/demonstrates the relationship. Select a section of text within a Nodes in its **Detail View**. On the **Quick Coding** bar change the location in the drop-down menu to **Relationships**. In the **Code At** section, choose the relationship in the **from** area in the drop-down menu (start typing its name and NVivo will narrow-down the options for you). You can also create a new relationship enter the appropriate information in the **from**, **Relationship Type** and **to** sections. Then click the **Code at current Nodes** icon (c).

### How to See What Has Been Coded within a Source

Double-click on the source to open it, then go to the **View** menu tab, and click on **Highlight** and select the appropriate option:

- **All Nodes** will highlight everything that is coded in yellow. It doesn't tell you how it’s been coded.
- **Selected Items** will highlight the coding for the Nodes you choose from the menu. (available ones will be in bold type). To reset these choices, select **Modify Selected Items**.

To see how it’s actually been coded at multiple Nodes turn on **Coding Stripes** on the same tab. Click on **Coding Stripes** and select the appropriate option (e.g., **All Nodes Coding**). Colour-coded stripes will appear in another window on the right-hand side of the screen. These tell you how the sections have been coded and the coding density. You can click on one of these stripes to highlight the coded text for that Nodes (e.g., **Real Estate Development**). You can right-click on a strip to hide it and to automatically **uncode all the text in that document at the Nodes** (right-click and **Uncode at Node**). To unhide a strip, select **Modify Selected Items** from the Coding Strip drop-down menu and re-tick the appropriate Nodes.

### Coding Audio and Video data

**Example:** Code the audio data for the Interview **Helen**.

You can code audio and video data in two ways: by selecting the text in the written transcript or by selecting sections of the media via the timeline. Coding the transcript is identical to coding normal text data. Open the audio file for **Helen** in the **Interviews** folder. If you want to code using the timeline, click and drag to select the portion of timespan you want to code. On the **Analyze** tab under **Code Selection At**, click **New Node** (or **Existing Nodes**). Choose where you want to store the Nodes in the **Location** box, enter a **Name** and (optional) **Description** and click OK.

If you have a transcript as well, the portion of the transcript which is coded in the timeline is indirectly coded also (but the transcript will not be shown in the Nodes when you open it). When you open the Nodes, you will see a link to the section of audio and its related transcript on the **Audio** tab.
**Coding Pictures**

**Example: Coding a boat in the picture file Competing Water Uses.**

You can code pictures in three different ways: by selecting a region of the picture (e.g., the photo Competing Water Uses in the Area and Township internal folder), coding text in the Content column of the picture log (if you have one) or by coding the entire picture source in one. Again, coding the log is identical to coding normal text data. If you want to code the whole picture to a Nodes, code the source as described previously. If you want to code only a section of a picture (e.g., one boat in a photo), click and drag to select the section you want to code. On the Analyze tab under Code Selection At, click New Node (or Existing Nodes). Choose where you want to store the Nodes in the Location box, enter a Name and (optional) Description and click OK.

PDF documents can also be coded as though they were pictures (e.g., areas of the document rather than words in the document). Right-click in the Detail View and select Section Mode then Region instead of Text.

**Uncoding Within Nodes and Sources**

If you make a mistake when coding, or if there are references found in Nodes or the results of queries that do not really fit in with the theme behind the Nodes, you can always uncode that section of text/picture/video/audio. Highlight the reference section to be uncode, right-click on the selection and chose Uncode Selection and then Uncode at this Node (can also uncode it in other Nodes it may be coded at).

The same can be done using the short-cut for coding, by just clicking on the Icon for Uncode at Current Node (when the right Nodes is in the Code At box).

You can also uncode ALL the references in one source at a Nodes using the Coding Stripes, by right-clicking on the coding stripe for the appropriate Nodes, and uncoding at the Nodes.

---

**Extra Information on Working with Audio & Video:** You do not need to transcribe in order to code Audio and Video files. However, remember that NVivo cannot search audio and video content when conducting Word and Text Search queries.

---

**Giving an Entire Source a Classification and Attributes**

In the Sources Area of the Navigation View, find and click on the source you want to code (e.g., ANU Home Page). Right-click on the source name and then select the relevant Properties option in the menu. Click on the Attribute Values tab and select the type of Classification you want to give it (e.g., “Reference”). Then select the appropriate Attributes from the drop-down lists. Click OK when you are finished.

**Coding an Entire Source to a Node [Optional]**

In the Sources Area of the Navigation View, find and click on the appropriate source you want to code (e.g., Interviews). Right-click on the source and then select the Code Source option in the menu and either:

- **Code Source at Existing Node** - in the Select Project Items menu tick the appropriate check-boxes.
- **Code at New Node** (e.g., “Face to Face”) - select the appropriate location to store the new Nodes and store as either a stand-alone Nodes (e.g., select the higher-order Nodes folder), or as a child-Nodes (e.g., click on the Nodes you want to be its parent.) Give the new Nodes a name and (optional) description.

Then click OK.
NVivo Introduction

Collections Area

This Area stores links to project items in folders to make them easier to organise and find. It is particularly useful if you are collaborating with other researchers on the same project.

- **Sets** – manually organised group of sources or Nodes (e.g., a folder for "audio files still to transcribe"). (More about this next session).
- **Search Folders** - automatically organised groups of items that meet a search criteria.
- **Memo Links** - any memos you have made in your project are linked here.
- **See Also Links** - any hyperlinks you have made between project items.
- **Annotations** - any annotations you have made in your project are linked here.

Creating Annotations

Example: Annotate the ANU Home Page pdf.

Select the content you wish to annotate (e.g., *ANU Home Page*) and on the **Analyze** tab click **New Annotation**. Enter the annotation text at the bottom of the **Detail View**. Annotated content will be highlighted in blue and the text will be displayed in the **Annotations** tab at the bottom of the window. This text can also be included in any text searches and/or queries.

Creating Memos

You can use memos to record any ideas or insights as you progress in your analysis. These can be linked to specific **Sources** or **Nodes**, or **Unlinked**. Memos can include text, tables and annotations. In addition, you can code the content of memos. You can also import existing memos into the Memos folder. Sources that have linked memos display a memo link icon:

Example: Create an Unlinked Memo for **Things to Do**.

To create an unlinked memo, in the **Sources** Area, click the **Memos** folder. On the **Create** tab, click **Memo**, enter a name (e.g., *Things to Do*) and (optional) description, and then click **OK**. It will open in the **Edit Mode** so you can enter content. If you want to link a memo to source/Nodes, click the source/Nodes then on the **Analyze** tab click **Memo Link** and then **Link to New Memo**. Enter a name and (optional) description, then click **OK**.

Creating Links

Example: Link the ANU Home Page to another source.

Select the content you want to link from (e.g., a selection of text from the *ANU Home Page*), and on the **Analyze** tab, click **See Also Link** and then **New See Also Link**. Click the **Select** button, locate and on the left select the folder that contains the source you want to link from. Then on the right, select the source you want to link it to (e.g., *Survey Responses* in the **Internal sources** folder), and click **OK**. Linked content will be highlighted in pink and the linked item will be displayed in the **See Also Links** tab at the bottom of the window.

**Note**: If you want to view/hide annotations and links from the Detail View, click on the **View** tab and tick/untick the appropriate boxes in the Links Area.
Deciding on a Coding Scheme: Word Frequency Queries

In the initial stages of deciding on a coding scheme to use, a Word Frequency Query could be useful. This will produce results of the words that occur the most often in the text documents you have (including memos, transcripts etc.).

Example: Word Frequency Query in all Interviews.

On the Query tab, click on Word Frequency. This will open a new Detail View with the word frequency options. Choose where to search in the Search in (e.g., Selected Items and select the Interviews folder). Then decide if you want to limit the number of results (by default to the 1000 most frequent) and the largest letter-length of the words you want to limit results to (default is 3 letters so you don’t get words like “to”, “a”, “an” or “I”). In the Grouping Area, decide on the matching criteria by sliding the indicator (e.g., 3 - see table below for descriptions of the 5 levels):

The five Text Match levels:

<table>
<thead>
<tr>
<th>Level</th>
<th>Returns</th>
<th>Example (sport)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Exact matches only</td>
<td>sport</td>
</tr>
<tr>
<td>2</td>
<td>Exact matches Words with same stem</td>
<td>sport, sporting</td>
</tr>
<tr>
<td>3</td>
<td>Exact matches Words with same stem Synonyms (words with a very close meaning)</td>
<td>sport, sporting, play, fun</td>
</tr>
<tr>
<td>4</td>
<td>Exact matches Words with same stem Synonyms (words with a very close meaning) Specializations (words with a more specialized meaning)</td>
<td>sport, sporting, play, fun, running, basketball</td>
</tr>
<tr>
<td>5</td>
<td>Exact matches Words with same stem Synonyms (words with a very close meaning) Specializations (words with a more specialized meaning—a ‘type of’) Generalizations (words with a more general meaning)</td>
<td>sport, sporting, play, fun, running, basketball, recreation, business</td>
</tr>
</tbody>
</table>

Note: The higher the similarity, the longer it will take to run.

Then click Run Query. If you want to save the query details and run it again later in the Queries Area, click Add to Project as well).

Note: A Text/Word Search query does not search text within PDFs created by scanning paper documents (each page is a single image). Consider using optical character recognition (OCR) to convert the scanned images to text before importing.

Note: Only words in the content fields are included in queries when searching audio and video transcripts and only in codable fields in datasets.
Word Frequency Results

From the results in the **Detail View** you can decide on an appropriate coding scheme and even begin to create Nodes. To **view the actual references** found in the query results in their context, double-click on the word in the table. This opens a new tab in the **Detail View** containing sections of all the references containing the word. There are also tabs for graphical representations of your query: **Word Cloud**, **Tree Map** and **Cluster Analysis**.

### Word Clouds

The **Word Cloud** displays up to 100 of the most frequent words with each varying in font size: the largest fonts related to the most frequently occurring words, and the smallest the least frequent.

You can double-click on any of the words in the cloud to see the results in context also.

### Tree Map

A **Hierarchy Map** is a diagram that shows hierarchical data as a set of nested rectangles of varying sizes. Like a **Bar Chart**, you can use them to compare the number of coding references: the largest rectangles represent Nodes with the most number of coding references, and the smallest rectangles the least. In the example below, **solar power** has the most references, and **geothermal** the least. Also, there are more coding references for the child Nodes of **alternate energy** than either **fossil fuels** or **nuclear power**.

As with all graphics, **Tree Maps** provide links to actual references.
Cluster Analysis

The Cluster Analysis tab contains a tree-diagram describing the relationships between the words in the query based on their co-occurrence. This can help by providing more context.

Expanding the Context of References

Sometimes when you have run a query, the context for the references in the Nodes can be quite narrow (e.g., only a few words) and you need to see more information to assess whether or not it can be coded in the way you think.

Within the Query Results you can right-click on the reference in the Detail View, and select Coding Context and choose the level you want:

- **Narrow** to see 5 words, 5 seconds or 5 percent on either side of the coding reference, or (for datasets) see all the text in the cell.
- **Broad** to see the surrounding paragraph, cell or row, or see 20 seconds or 20 percent on either side of the coding reference
- **Custom** to define specific reach settings

You can also do this through the menus by selecting the reference and on the View tab click Node, then change the Coding Context. To expand the context of all references in the Nodes, press CTRL+A to select all of the text and then change the context.

If you want the coding itself to include a broader/narrower context permanently in a specific Nodes, when you are in that Nodes’s Node View you can spread/reduce the coding, by clicking on the reference and on the Analyze tab click Spread Coding. Click the required context reach.

Creating a Node from Query Results

**Example:** Create a Node for fishing from the results.

If you decide to create a Nodes for the word in your query result, right-click on the word in the Detail View (e.g., fishing) and select Create as Node. This will create a Nodes that automatically codes all references to that word (and will appear in the Node View).

**Note:** NVivo will just create a Nodes for the word found in that query if you only asked for exact matches (Text Match Level 1) and no context.
Excluding Irrelevant Words from Searches

In the results you might see words that you do not want to include in the query search in future, such as “any”. Right-Click on the word in the results and select Add to Stop Words List. If you have included more than exact matches in the text match level section (i.e., >level 1), you must remove any words in the box which you still wish to be included in future searches. When you are ready, click OK. Every time you run a query from now on, these words will not be included in results. You can edit these in Project Properties at any time: on the File tab under Info select Project Properties and on the General tab click the Stop Word List button and edit the words to exclude.

Creating Transcripts

You can create transcripts in 3 ways: Transcribe Mode, Normal Mode and by dividing the media into sections. For further information on importing audio and video transcripts, see http://help-nv11.qsrinternational.com/

Transcribe Mode

Example: Transcribing the audio file for Helen.

By using the Transcribe Mode, you can play, pause, forward or rewind as you transcribe, and each time press stop, NVivo creates a new transcript row and timestamp. Open the media source and click on Edit Mode. On the Media tab under Play Mode, click Transcribe. On the Media tab click Play Speed, and select your preferred speed. In the Playback group, click Play/Pause. A new transcript entry will be added. Enter the text for the section (you can pause, rewind and skip back while transcribing at any time). Click Stop when you have completed an entry, then the end time is added to the Timespan field. Continue playing and stopping until you have finished transcribing. Then turn off Transcribe Mode on the Media tab and under Play Mode click Normal.

Normal Mode

You can add transcript entries directly in Normal Mode, by adding a transcript row for a selected timespan and entering the content. Click on Edit Mode, then click and drag on the timeline to select the timespan. On the Layout tab, in the Rows & Columns group, click Insert and click Insert Row. You can also add a new entry without a timestamp this way (e.g., to make general comments) simply by typing in the next entry box.

Dividing Media

You can divide the media into sections by adding multiple transcript entries of equal duration. E.g., divide a 30min video into 5min sections then comment on dialogue/events in each. On the Layout tab under Rows & Columns, click Insert and then click Insert Rows. In the Add Transcript Rows of Duration field enter the duration of each entry (e.g., 5:00 to create entries of 2mins duration). In the From Start Time field, enter the start time for the entries (e.g., 00:00:00 to start adding entries from the beginning of the media). In the To End Time field, enter the end time for the final entry (e.g., 00:15:00 to end the final entry at 15mins). Click OK.

Custom Fields in Transcripts

If you want to add columns in the transcript for information, such as the speaker's name, click the File tab, point to Info and click Project Properties. Click the Audio/Video tab and under Custom Transcript Fields click the Audio or Video tab. Click the New button and enter a name for the new field. The field will be add to all transcripts in the project. You can use this field when auto coding also.
Other resources

Training notes
To access the Information Literacy Program’s training notes, visit the Research & learn webpage (anulib.anu.edu.au/research-learn) and select the skill area followed by the relevant course. You can register for a workshop and find other information.

Research & learn how-to guides
Explore and learn with the ANU Library’s how to guides (ql.anu.edu.au/howto). Topics covered are:

- Citations & abstracts
- Data Management
- EndNote
- Finding books and more
- Finding journal articles and more
- Finding theses
- Increasing your research impact
- NVivo
- Topic analysis
- Using Google scholar from off-campus

Digital badges
Earn Digital Badges by completing the Library’s online courses (Search skills and strategies, EndNote: collect, curate, create and Increasing research impact). Self-enrol by logging in to Wattle (ql.anu.edu.au/badge).

Online learning
Online learning is available through ANU Pulse (ql.anu.edu.au/pulse), which can be accessed from both on and off campus by all ANU staff and students.

IT skills development modules available in ANU Pulse
- Microsoft Office (Access, Excel, OneNote, Outlook, PowerPoint, Project, Visio, Word)
- Microsoft Office (Mac)
- Adobe suite (Illustrator, Photoshop)
- Other IT (Concepts of IT, FrontPage, Internet Explorer, Type IT, Windows)

Training calendar
Select Events » near the bottom of the Library homepage to access our events calendar with upcoming training opportunities displayed day by day (ql.anu.edu.au/cal).

Feedback!
Please provide feedback about today’s workshop via an online feedback form (ql.anu.edu.au/survey)